SAMWONTECH CO.,LTD
Temperature Controller(NOVA500/300, SP790) Series

PCC 0/1 Driver
Giddings Lewis

Supported version  TOP Design Studio V4.0 or higher {Rl

CONTENTS

We want to thank our customers who use the Touch Operation Panel.

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 9

Describes how to set up communication for external devices.

5. cable table Page 10

Describes the cable specifications required for connection.

6. Supported addresses Page 11

Refer to this section to check the addresses which can

communicate with an external device.

External device connection manual for TOP Design Studio 1/ 1



1. System configuration
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The system configuration of TOP and “SAMWONTECH CO., LTD. — Temperature Controller Series” is as follows:

Link I/F

Communication method

System setting

Series ‘

SD590 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
SD560 on the Controller (2 wire) (Page 4) (Page 8)
SL590 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
SL540 on the Controller (2 wire) (Page 4) (Page 8)
SP590
SP580 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
NOVA500 SP570 on the Controller (2 wire) (Page 4) (Page 8)
SP540
ST590
ST580 .
7570 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
ST560 on the Controller (2 wire) (Page 4) (Page 8)
ST540
SD390 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
SD360 on the Controller (2 wire) (Page 4) (Page 8)
Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
55300 on the Controller (2 wire) (Page 4) (Page 8)
NOVA300 ST590
ST580 .
7570 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
ST560 on the Controller (2 wire) (Page 4) (Page 8)
ST540
SP790 Terminal Block RS485 3.1 Settings example 1 5.1. Cable table 1
SP790 SP791 on the Controller (2 wire) (Page 4) (Page 8)

H Connection configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422/485 communication.

* 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422/485 communication.
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H Select a TOP model and a port, and then select an external device.

Select Device n
PLC select [COM2]
Filter : |[.q||] ~ Search :

(CiModel (@) Vendor

Vendor

SAMWONTECH

4 Back | B Next *® Cancel

Select Device n

PLC Setting[ Temperature Controller Series ]

Alias Name : PLC1
Interface : | Computer Link ~
Protocol : | Nova Link v

Comm Manual

String Save Mode : |First LH HL Change

[J use Redundancy

AND v
TimeQut 5 :
Condition Edit
Primary Option
Timeout 300 &|| msec
Send Wait msec
Checksum use

@ Back « oK *® Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.
Select
SAMWONTECH CO,, LTD.
PLC Select an external device to connect to TOP.

Select

“Temperature Controller - NOVA500/300, SP790 Series PCC 0/1".

connect is a model whose system can be configured.

Please check the system configuration in Chapter 1 to see if the external device you want to
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3. TOP communication setting
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interfac

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

e setting

— Set the TOP communication interface in TOP Design Studio.

Project Option

- Change HMI[H]

“ Add PLC[A] | TRl Change PLCICI

-3 TOP Setting

v -l Option Module Setting
. -4 FieldBus (0)
| L. RFID (0)
™ - Device Setting
~-fg® COM1 (D)
v g8 COM2 (1)

~-fg® COM3 (0)
-l Ethernet (0)
g Wireless (0)
-l USBDevice (0)

- PLC1 : Temperature Controllg

Date / Time Sync.  Screen Option

Project Option = Screen Change

Use HMI Setup

HmiSetup

E] Delete PLCD]

Unit Convert

Global Lock & Touch

Project Style  Splash

PLC Buffer Sync.

Initialization

Edit

Start Mode =Menu

Start Saeen No.=1

Latch Use=0

Latch Set=0~0

Communication Error Message=0
USBErrorMessage =0
StorageErrorMessage=1
DatabaseMessage=1
SystemMessage=1
DisplayLocklcon=0

Control Panel

System m[)evices :nﬂService _'—'"'_'Dption

o Gerial ot ]
e =
T r(8 .
Serial Port: | COMZ '
PLLC S it DatesTi
eCurity at e /Time Signal Level
RS-232C0 () Rs-422(4) () RS-485(2)
: Baud Rate: 35400 <
L] ofemef = -
Data Bit: & -
Et hernet Serial HOK | Stop Bit: 1 .
—— Parity Bit: HNone h
— % Flow: (ff
L -l . Ping
: : e - Auto Search| Loopback Test
Diagnost ic File Fing
Manager
Apply Cancel
Items TOP External device Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.

External device connection manual for TOP Design Studio

4/ 11



(2) Communication option setting
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M [ Project > Project Property > Device Setting > COM > "PLC1 : Temperature Controller - NOVA500/300, SP790 Series PCC 0/1"]
— Set the options of the SAMWONTECH CO., LTD communication driver in TOP Design Studio.

Project Option

- Change HMI[H] ' Add PLC[A] | THiTal Change PICIO | 1] Delete PLCID]

TOP Setting = o
: PLC Setting[ Temperature Controller Series
i .3 5YS:RD1520% 9l pe ]
W Option Module Setting Alias Name : |PLC1 |
W FieldBus (0) Interface : | Computer Link ~
- RFID (0)
Device Setting Protocol : |Nova Link ~ Comm Manual
-~ TgW COM1{(0) String Save Mode : [First LH HL Change
W W COM2 (1)
i - PLC1: Temperature Controlle
=¥ COM3 (0) [] use Redundancy
8 Ethernet (0) AND ~
- Wireless (0) _ - =~
9 USBDevice (0) Bl
C Edit
Primary Option
Timeout 200 < | msec
Send Wait msec
Retry 5 z
Station No 1 -
v
Checksum use Ve -
£ >
Apply Close
Items Settings Remarks
Interface "Computer Link ]
- Fixed
Protocol PC Link

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device and

sending the next command request.

Retry

Retry attempts upon communication failure.
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3.2. Communication setting in TOP
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Bun

(- i o}

Conikrol Panel

Serial

Serial Port: lCDME

Signal Level

() RS-232C O RS-422(4) @ RS-485(2)

Baud Rate: | 38400
Data Bit: |8
Stop Bit: | 1

Parity Bit: [ Mone

Flow: | (¢

YHC
Yiewer |
] [ -~
Et hernet Serial
screen %
shot h
Diagrost ic File
Manager
ill.
[System]
Items TOP

Close

rl'

—

External device

Remarks

Signal Level (port)

RS-232C/RS-485

RS-232C/RS-485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
B [Main Screen > Control Panel > PLC]

il PLG

®

Dr i ver (COM2)

PLC1( Temperature Controller Series) vl

Run — .
Interface | Computer Link R
!h'l Protocol | Mova Link R
FLC Timeout 300 5] msec

Send Wait

¥HC

S T I

FPEmyg H =
| | E Ethernet Station b ﬂ
n Checksum Yes ||
Ammd
Screen m
shot
Diagnost ic
[System [ Diagnostic [ App |y “Cancel l

Items Settings Remarks
Interface “"Computer Link )
- Fixed

Protocol PC Link
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.
SendWait (ms) Set the waiting time between TOP's receiving a response from an external device and

sending the next command request.
Retry Retry attempts upon communication failure.
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3.3 Communication diagnostics

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system oK NG ) )
) ) - 1. System configuration
configuration Connection cable name OK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) OK NG . .
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings oK NG ) )
4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP.
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TOP 225 -
5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

M 1:1 connection

(A) TOP COM Port (9 pin)

TOP COM Temperature Controller
Pin Signal Pin Cable connection Signal .
arrangement*Note 1) name number name Pin arrangement
1 5 RDA 1 RTX(+)
g g 3 SG RTX+
Based on RDB 4 —? r

communication G 5 A RT}{_ m
cable connector SDA 6

front, 7 SG
D-SUB 9 Pin male 8
(male, convex) SDB 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

(B) TOP COM Port (15 pin)

TOP COM Temperature Controller
Pin Signal Pin Cable connection Signal Pin arrangement
arrangement*Note 1) name number name
- 1 RTX(+)
© © (Omitted) RTX(-)
" sc RTX+
Based on _ 10
communication RDA 1 _T RT}{_ m
cable connector RDB 12 _l
front, SDA 13 SG
D-SUB 15 Pin male SDB 14
(male, convex) SG 15

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

B 1:N connection — Refer to 1:1 connection to connect in the following way.

TOP ) . o External device Cable connection and signal External device

———— Cable connection and signal direction - o -

Signal name Signal name direction Signal name

RDA RTX(+) RTX(+)
RDB RTX(-) RTX(-)
SDA — SG SG
SDB
SG
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6. Supported addresses
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Parameter | Descriptions Remarks

COM.P Standard protocol 1 | Standard protocol + Check Sum Select protocol

BAUD 9600 5 | 19200 Transmission speed

SPRY NONE No Parity | EVEN | Parity (Even) | ODD | Parity (Odd) | Parity

SBIT 1 | 1BIT 2 | 2BIT Stop Bit

DLEN 7 | 7 BIT 8| 8 BIT Data Length

ADDR 1 Device Station ID No.
RPTM 0 Response time: Processing

time + RPTM + 10msec

*Note 1) Depending on the equipment, transmission speed of 19200 bps may not be supported.

The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Device Bit Address Word Address Remarks
D Register Range
supported (ALL) D0000.00 — D9999.15 D0000 - D9999
PROCESS D0000.00 — D0099.15 D0000 — D0099
FUNCTION D0100.00 - D0199.15 D0100 — DO199
SET POINT D0200.00 - D0299.15 D0200 — D0299
SIGNAL D0300.00 - D0399.15 D0300 — D0399
ALARM D0400.00 — D0499.15 D0400 — D0499
PID D0500.00 — D0599.15 D0500 - D0599
IN/OUT D0600.00 — D0699.15 D0600 — D0699
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